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Please read and understand all the instructions to avoid injury to yourself and damage to the device

Do not expose to extreme
temperatures (above 95°F or
below 23°F). Do not expose to
moisture.

Do not apply excessive pressure
to the device.

Do not let any foreign matter spill
into the device. 

Do not place heavy objects on top
of the device.

Do not expose to chemicals such
as benzene and thinners. 

Do not expose to direct sunlight
or heat sources. 

Do not store in dusty areas. Do not try to disassemble and
repair the device yourself. 

Do not drop the player from the
high place.

Earphones

Follow Traffic Safety Instructions

● Do not use earphones while driving an automobile or riding a bicycle.
● It is not safe to listen at high volume while walking down the street, especially while

crossing at intersections.

Protect your ears

● Do not turn the volume too high. 
Doctors warn against prolonged exposure to high volume. 

● If you have ringing in your ears, turn the volume down or discontinue listening.

Environmental Information 

● Follow local guidelines for waste disposal when discarding packages, batteries, and old
electronic appliances.

● Your  player is packaged with cardboard, polyethylene, etc. and does not use any
unneccessary materials

Ambient Operating Conditions

● Ambient temperature: 5°C ~ 35°C (41°F ~ 95°F)
Humidity                  : 10 ~ 75%

Safety Guidelines
- Safety Instructions



6 -  Samsung Napster YP-910 Player Samsung Napster YP-910 Player - 7

!
CAUTION

RISK OF ELECTRIC SHOCK. DO NOT OPEN

The uninsulated parts inside the charger could cause
electric shock.
For your safety, do not open the case of the charger.

! Read this User Manual to prevent any problems that
may occur while using the charger.

Warning
● Use the charger away from water sources to avoid fire or electric shock.

Caution
● Use the charger only with a power outlet that matches the shape of the 

converter's plug to avoid electric shock.
● Make sure that the charger's plug is inserted all the way into the outlet.

Here is a quick outline of the basic steps you need to take to get up and
running with your Samsung Napster Player. 
Page references are provided if you need additional help

1. Charge the battery (see page 8).

2. Install the Napster software (see page 18).

3. Connect your Samsung Napster Player to your PC with a USB Cable

(see page 20).

4. Transfer music to your Samsung Napster Player

(see page 32).

5. Play music (see page 40).

Safety Guidelines
- Battery Charger Safety

Introduction
- Quick Start
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Caution
● Do not charge longer than the specified charge time to avoid risk of fire.
● Do not plug several devices into the same outlet.
● Do not use a rechargeable battery or charger that is defective.
● When using the rechargeable battery for the first time or after several months of 

non-use, fully charge it before use.
● Do not charge the rechargeable battery for more than 24 hours.
● Overcharging or overdischarging will reduce the battery life.
● The rechargeable battery is consumable items and its capacity will decrease gradually.
● To prolong the life of your battery, use the fully charged battery until it is completely

discharged, and then fully charge it again before use. If you charge the battery that is not
completely drained, the battery operating time will decrease. In this case, fully cycle (fully
charge and then fully discharge) the battery several times.

● Do not let metallic objects, such as necklaces or coins, come into contact with the
terminals (metallic parts) of the charger and the built-in rechargeable battery. 
A fire or electric shock may result.

A charger is supplied with your Samsung Napster Player.

Plug the charger into a wall outlet.
❈ Red light indicates that the

battery is being charged.
❈ Green light indicates that the

battery is fully charged after
charging

When downloading or uploading files 

The rechargeable batteries drain quickly when you
download or upload recorded files. Always use the charger
when transferring files.

Introduction
- Charging the battery 
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Fully Integrated with Napster
Transfer the tracks you purchase with Napster seamlessly to your 

Samsung Napster Player, and use Napster to access and manage your 

entire online collection.

Mass Storage Hard Disk
You can use the built-in 20GB hard drive to store your entire music library, 

plus use it as an external drive on your PC to store other data files.

MP3 Recording Capability
You can convert music from CDs, cassettes, and radio into 

MP3 files without a PC.

Remote Playback Via FM Transmission
Play music through your home or car stereo with a built-in wireless 

FM transmitter.

MP3 & WMA Playback
Your Samsung Napster Player supports playback of both MP3 and WMA.

High Speed Transfer via USB
Maximum transfer speed of 120 Mbps.

High-Fidelity Sound 
The Samsung Napster Player has a built-in equalizer to adjust sound to
your preference. 

Built-in Rechargeable Li-Ion Battery
The built-in rechargeable lithium battery provides up to 10 hours of 
play time.

Introduction
- Samsung Napster Player Feature Overview
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● Napster is the premier online music service that gives you instant access

to over half a million tracks. Tracks purchased on Napster can be

seamlessly transferred to your Samsung Napster Player.

● If you sign up for the Napster Premium service, you can also get

unlimited streaming and downloading of tracks to play on your computer,

as well as access to other Premium features.

● This user manual contains instructions for using your 

Samsung Napster Player with Napster. Additional help for Napster is

available from the online User Guide and FAQs available from the

Napster Help menu. 

Minimum system requirements are as follows:

● Operating System: Windows 2000 or Windows XP

Note : Napster is not supported on Macintosh or Windows 95, 98, NT, or ME.

● Processor: Pentium-class CPU equivalent or better

● Memory: 64MB of RAM minimum

● Hard Disk space: Approximately 9 to 12 MB for the  Napster installer and 

100 MB for Windows Media Player 9 Series (if not already installed)

● Sound card and speakers

● Browser: Microsoft Internet Explorer version 5.01 or higher 

Note : For IE 5.5 users, service pack 1 or higher is required.

● Windows Media Player 9 Series 

● Active Internet connection 

(33.3 Kbps minimum, broadband/128+ Kbps recommended)

● USB Requirement: USB 2.0 required for maximum transfer rate

● CD-ROM Drive

Introduction
- Napster Overview

Introduction
- System Requirements
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Player
AH92-01977A

Earphones
AH30-00056B

Line-In Cable 
AH39-00488A

User Manual
AH68-01380B

Charger
AH44-00036B

USB Cable
AH39-00540A

FM Transmission
Antenna

AH42-00009A

Menu
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Installation CD
AH80-00056A

Carrying Case
AH61-01494A

● Car-lighter adapter is sold separately.
● The appearance of the accessories shown is subject to change for product

improvement without prior notice.
● If an accessory has been lost, stolen, or destroyed, a replacement may be

purchased from a Samsung Service Center.

Remote Control
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USB port socket/
Charger terminal

Line-in jack/
FM transmission antenna jack

Earphone jack/
Remote control jack

Display panel

Hold switch Power On/Off
Play/Pause/Skip/Fast
Search button

Volume down/Scroll
down button

Volume up/Scroll up
button

Select button

Reset hole 

Record button

Menu button

Note
Reset the player by pressing the reset hole
using a sharp pointed tool such as a pin.

Introduction
- Components

Introduction
- Location of Controls
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DisplayFront

Earphone jack

Hold switch

√»: Play/Pause
œœ/√√: Fast REW/FF
+/–: Volume control

Back

Belt clip

Song number display

Hold indicator

Battery remaining indicator

Artist display

Album display

Track display

Elapsed track time

Playback status

Mode indicator

NOW PLAYING

Now Playing  01 of 10

artist Norah  Jones
Come Away With...
Seven Years

album

track

00:15 06:25

PLAY

Remaining track time

Introduction
- Location of Controls (Remote Control)
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1. After you have completed the installation, create a member name and
password. Enter the required information and click [submit].

This completes your installation and registration of Napster. To find out
more about the Napster Premium service click [yes, tell me more].
Otherwise, click [no thanks, just sign me in] to sign in to Napster and
start purchasing tracks to transfer to your Samsung Napster Player.

Note
If you already created your member name
through a retailer’s registration program,
follow the [I am already a member] link in
the upper right corner.

Installation and Setup
- Registering for a Napster Account 

The Napster application is included with the installation CD that came with your
Samsung Napster Player. Before you install the Napster software, review the system
requirements on page 13. If you don't already have Windows Media Player 9, it will
automatically be installed as part of the installation process. 

You will first need to install the Napster application:

1. Insert the installation CD that came with your Samsung Napster Player
and follow the directions to install Napster.

2. Follow the on-screen instructions as the InstallShield Wizard guides
you through the installation. When the installation has completed, click
[Finish].

Installation and Setup
- Installing the Napster Software
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Connecting your Samsung Napster Player 
to your PC with a USB Cable

● A message appears, indicating that a new device has been found, and
the USB driver will be installed. If the USB driver does not install
automatically, restart your PC and try again.

Note

Follow these steps to verify that yourFollow these steps to verify that your
USB driver installed successfully:USB driver installed successfully:
Windows 2000 Professional: 
Control Panel ➝ System ➝ Hardware ➝ Device Manager 

Windows XP Professional: 
Control Panel ➝ Performance and Maintenance ➝ 

System ➝ Hardware ➝ Device Manager 

If the USB driver is installed, 
"Samsung/Napster YP-910" will appear 
under "Universal Serial Bus Controllers."

Charge the battery on the Samsung Napster
Player, and then press the On/Off button to
turn on the power.

1

Connect one end of the USB cable to the
USB port on your PC.2
Open the Samsung Napster Player's upper 
door and connect the other end of the 
USB cable to the USB cable socket.

If you disconnect the USB cable while Napster 
is initializing or executing a command, your PC may
malfunction. Be sure to perform a safe removal before
physically disconnecting the USB cable.

For instructions on safely removing your device, see page 34.

3
!

Installation and Setup
- Checking the USB Driver 
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Changing the "Hidden files and folders" option
Uploading recorded files

In Windows Explorer, click [Folder Options]
on the [Tools] menu.

Choose the [View tab].

1

In order to be able to upload recorded files to a PC, you must first
change the "Hidden files and folders" option on the View tab in the
Folder Options.

2
3

In Windows Explorer, select the drive
indicated by "YEPP", and then click the
\System\music folder.

Drag and drop the recording file
(M✻✻✻.mp3) you want to upload to the
PC onto the folder where you want it
stored.

1

2
Check the item 
[Show hidden files and folders].

Caution
Never delete or modify other folders or files in the yepp system folder.

Installation and Setup
- Uploading recorded files to a PC
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Here are some things you should know about tracks purchased on Napster:

● Tracks purchased on Napster are yours to keep and 

can be burned to CD and seamlessly transferred to your 

Samsung Napster Player.

● You can have your purchased tracks on up to three computers. 

To copy your purchased tracks to another computer, use the

[Sync/Restore] feature on Napster available from the [My Account]

menu.

● The unlimited downloads that come with the Napster 

Premium service cannot be transferred to your device until 

they have been purchased. 

Note
If you try to transfer to your Samsung Napster Player tracks that have not yet been
purchased, you will automatically be prompted to purchase the tracks. 

To search for and purchase music on Napster:

1. Launch the Napster application by double-clicking the Napster icon on your desktop.

Note
If you do not have the Napster application, see page 18 for instructions on
installing Napster.

2. If there is a specific track you are looking for, simply type the artist, album, or track
name in the search field in the upper right corner, select the [search] type from the
drop-down menu, and click search. If you do not know specifically what you are
looking for, you can go to the Browse tab to browse for music by genre.

5. A confirmation page with your selected tracks is displayed. Click [Next].
6. If it is your first track purchase and you are not a Premium service member,

you will be prompted to enter your credit card information.

Once you purchase the track, the track is automatically downloaded to your
Napster Library. Purchased tracks can then be burned to CD and 
transferred to your Samsung Napster Player.

3. Select the track(s) you would like to
purchase.

Note
You can also purchase an entire album by clicking the
provided [buy album] link or selecting a track on the
album, right-clicking, and choosing [Buy Album].

4. Click the [buy track] button, or 
right-click and choose [Buy Track(s)].

Using Napster with Your Samsung Napster Player
- Searching for and Purchasing Music
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You can use Napster to import existing WMA or MP3 files into your Napster
library. Once these imported tracks are in your Napster Library, you can add
these tracks to playlists and transfer them to your Samsung Napster Player.

Note
If you do not have the Napster Premium service and you attempt to import
Napster tracks sent to you by other Napster members, you will be prompted
to either purchase the tracks or sign up for the Napster Premium service. 
Any other protected WMA files will require that you have the correct license for
those tracks to import them into Napster.
If you purchase the tracks, you can burn them and transfer them to your
Samsung Napster Player. If you sign up for the Napster Premium service, the
imported tracks are treated as regular Napster downloads. 

To Import WMAs or MP3s into your Napster Library:

1. Select [Import Track(s) to My Library] from the [File] drop-down
menu on the Napster application. 

2. Browse to and select the directory where the tracks are located from 
the [Folder] window on the left. 

3. Select the particular tracks from the [Files] window on the right. To select
multiple tracks, hold down the [Ctrl] or [Shift] keys while selecting, or
click [select all].

4. Click the [OK] button.

5. A progress bar displays while the tracks are importing. 

When the tracks successfully import, they will be stored and accessible 
from your Napster Library. You will also be prompted to edit the track 
data for any non-Napster tracks (see next section).

Using Napster with Your Samsung Napster Player
- Importing Your Existing Music
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After you import non-Napster WMA or MP3 files into your Napster Library,
you can edit the associated track information that affects how the tracks is
displayed within Napster and your Samsung Napster Player.

Note
After you successfully import tracks, you will automatically be prompted to edit
the track data.

To edit track data:
1. Select the track(s).

2. Right-click and Select [Edit Track Data].
3. Select the track from the [Track Filename] box on the left. 

4. Type in or edit the [Artist], [Album],
[Track] and/or [Track #] on the right. 
The track # specifies the order the 
track appears within an album. 

5. Click the [apply] button to apply the changes to that track. 

6. When finished, click [OK] to apply the changes and close the Edit Track
Data screen.

After you edit the track information, the correct data is displayed when you
view the tracks in your Napster Library.

To edit multiple tracks or an entire album at one time:

1. Select the track(s) or album. 

2. Select [Edit Track Data] from the [File] menu on the Napster application. 

3. Click [Select All], or select multiple tracks using the [Ctrl] or [Shift] keys.

4. Type in or edit the [Artist] and/or [Album] title. If the box is selected, this
change applies to all the tracks selected. 

5. Click the [apply] button to apply the changes to those tracks or album.

6. Once you edit the Artist and/or Album names for all the selected tracks, you
can go back to individually edit the [Track] and [Track #] for each track.

7. When finished, click [OK] to apply the change and close the Edit Track
Data screen.

After you edit the track information, the correct data is displayed when you
view the tracks in your Napster Library. 

Using Napster with Your Samsung Napster Player
- Editing Track Data
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To create a playlist using Napster:

1. Select tracks from within Napster that you would like in your playlist. 

Tip
Hold down the [Ctrl] or [Shift] key while selecting to select multiple tracks. 

2. Click the [add to playlist] button.

3. Type in a title for the playlist in the highlighted box.

4. Click [save].

After you create the playlist, you can continue to add songs by selecting 
the track(s), clicking the add to playlist button, and then selecting the 
playlist from the [add to playlist] screen.

Additional changes to your playlist can be made by locating the playlist
in your Napster Library:

● To rearrange tracks in your playlist, drag and drop the tracks in the desired

order.  

● To remove tracks from your playlist, right-click and select [Delete Track(s)]

from the drop-down menu or press the “Delete” key on your keyboard. 

● To rename your playlist, right-click on the playlist and select 

[Rename Playlist] from the drop-down menu. 

Note
Changes to playlists cannot be made while the playlist is on your device. 
To make changes to a playlist, make them on the playlist that is in your 
Playlists folder of your Library, and then re-transfer the playlist to your device. 

Using Napster with Your Samsung Napster Player
- Creating Playlists
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Tracks that you purchase through Napster can be transferred seamlessly to
your Samsung Napster Player using the Napster application. 

Note
Before transferring, make sure your Samsung Napster Player battery is
charged, otherwise your transfer may not complete successfully. 
When you plug your device into your computer through the USB port, the Napster
application will automatically recognize it and display it as Samsung/Napster YP-910
under the menu tree of your Napster Library.  If your Samsung Napster Player is not
connected or detected, it will display a “Portable Device” icon. 
If your Samsung Napster Player is not listed, check your connection and verify that the
Samsung Napster Player is detected by your computer. (see page 20).

Note
If you try to transfer tracks to your Samsung Napster Player that you have not purchased
yet, you will automatically be prompted to purchase the tracks.

Make sure your Samsung Napster Player battery is charged or connected to AC power.

To transfer tracks from your Napster Library to your Samsung Napster Player:

1. Locate the track(s) or playlist that you want to transfer in your Library.

Note
You can transfer tracks from anywhere else in Napster by right-clicking and selecting
[Transfer Track(s) to Portable Device].

2. Click and hold the mouse on the track(s) or playlist, then drag the tracks
to the listed Samsung/Napster YP-910 icon in the left pane of your
Napster Library (refer to the following figure).

Note
If the tracks are Napster tracks that you have not already 
purchased, you will be prompted to purchase them. 

Using Napster with Your Samsung Napster Player
- Transferring Music to Your Samsung Napster Player
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3. The progress of the transfer displays under Transfer Status. To view transfer
status, click on the + in front of Samsung/Napster YP-910 under your Library
to expand the sub-folders, and then click on [Transfer Status].

4. When the tracks have finished transferring, the status is listed as Complete.

Important Note
Do not disconnect the device while the transfer is in progress. 

5. Once the transfer is complete, you can disconnect your device by clicking the
unplug/eject icon on your Windows taskbar and following the instructions in the
message box that appears.

Important Note
Never unplug the device without first safely disconnecting. To safely disconnect or eject your
Samsung Napster Player:
Windows 2000
Click the "unplug/eject" icon on your Windows taskbar 
and follow the instructions in the message box that appears. 
Windows XP
Click the "Safely Remove Hardware" icon on your 
Windows taskbar and follow the instructions in the message 
box that appears. 

When you connect your Samsung Napster Player to your computer, you will
be able to view the music that is currently loaded on your device. You can
view your collected artists, albums, and playlists by clicking the
[Samsung/Napster YP-910] icon in your Library.

Besides removing tracks, you cannot modify the general organizational
structure of music on the device. You can play a track by double-clicking 
on it or by selecting it and clicking the play button. 

Note
You can only play the tracks stored on your device one at a time.
You can also only play tracks from the same computer that you used to transfer the tracks to your player.

Note
To modify a playlist that is on your Samsung Napster Player, make the changes on the playlist that is in your
Playlists folder of your Library, and then retransfer the playlist to your device. 

Using Napster with Your Samsung Napster Player
- Accessing Music on Your Samsung Napster Player
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To remove track(s) or playlists from your Samsung/Napster Player:

1. Verify that your Samsung Napster Player is connected to your
computer and displayed in your Napster Library as Samsung/Napster
YP-910.

2. Navigate to and locate the track(s) or playlist within the Samsung
Napster Player menu tree.

3. Select the track(s) and click the [remove] button or press the [Delete]
key on your keyboard. 

Note
You can delete a playlist, but the tracks will still remain on your player and will need to be
deleted separately.

If you have an existing playlist on your Samsung Napster Player that you
want to modify, you should do this through Napster. 

To modify an existing playlist using Napster:

1. Locate the original playlist in your Napster Library 
(not the one under your Samsung Napster Player). 

2. Make the desired changes (see the section on “Creating Playlists”).
3. When you have finished your changes, simply drag and drop the

playlist back onto the [Samsung/Napster YP-910] icon in 
your Napster Library. 

4. When prompted to overwrite the playlist on your device, answer [Yes].
5. The modified playlist will now be accessible from your Samsung

Napster Player.

Using Napster with Your Samsung Napster Player
- Managing Your Existing Playlists

Using Napster with Your Samsung Napster Player
- Deleting Music on Your Samsung Napster Player
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Additional help for the Napster application is available by clicking on the     

button from any screen, or through the Help drop-down menu. 

The following help options are available:

● User Guide: Comprehensive online instructions for using all the 
Napster features and functions

● FAQs: Answers to frequently asked questions about Napster
● Customer Support: If you are having issues or need help using Napster, 

you can fill out a help request form or find out how to 
contact Napster Customer Support by selecting 
Customer Support from the Help drop-down menu. 

Note
Napster Customer Support can assist with basic usage questions regarding your Samsung
Napster Player, but if you need technical assistance or have an issue related to the device
itself, you will need to contact Samsung Customer Support at 1-800-SAMSUNG. 

Using Napster with Your Samsung Napster Player
- Getting Help with Napster
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NOW PLAYING

Now Playing  01 of 10

artist Norah  Jones
Come Away With...
Seven Years

album

track

00:01 06:25

Now Playing

Library

FM Radio

Setting

FM Transmitter

Menu

STOP

NOW PLAYING

Now Playing  01 of 10

artist Norah  Jones
Come Away With...
Seven Years

album

track

00:30 06:00

PAUSE

NOW PLAYING

Now Playing  01 of 10

artist Norah  Jones
Come Away With...
Seven Years

album

track

00:35 05:55

PLAY

Turning Power On and Off
Power On: Press and hold the √» button to turn on the power.

Power Off: While in Pause or Stop mode, press and hold the √» button to turn off the power.

Playing Music Pausing Music

Select Now Playing in the menu.
To play a track, press the √» button.

Press the √» button to pause Playback.
● While in Pause mode, briefly press √»

again to resume playback.

Note
● WMA files can be played only if they are recorded with a compression rate between 14 Kbps to 192 Kbps that

Windows Media Player supports.

Using Your Samsung Napster Player
- Playing music 

Make sure the device is fully charged and the earphones are connected.

VOLUME

Now Playing  01 of 10

artist Norah  Jones
Come Away With...
Seven Years

album

track

00:15 06:25

PLAY

Adjusting the Volume

Press the up or down volume button to adjust
the volume.

Note
● The volume can be adjusted in increments 

between 0 and 20.
● Press once to adjust the volume by one level.  

Press and hold to increase or decrease the volume
in greater increments.  

Using Your Samsung Napster Player
- Adjusting Volume
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Searching for Specific Parts in PLAY Mode
● During playback, pull and hold the œœ / √√ to forward

or reverse search the currently playing file.

Searching for Music Files in
PLAY Mode.
● During playback, briefly pull the √√ to

play the next track in the playlist.
● Briefly pull the œœ to play the previous

track in the playlist.
● Press and hold the Menu button to display

the current playlist. Use the Volume Up,
down buttons to find the song you want and
press the √» to play it.

Searching for Music Files
in STOP or PAUSE Mode.
● While in stop or pause mode, pull the 

œœ / √√ to move to the previous or next
track in the playlist and play it
automatically.

Note
● VBR (Variable Bit Rate) File: 

An MP3 file that has varying
compression ratios.

● When playing a VBR file, even if
you press œœ within 5 seconds
after the start of playback, the
previous song may not be played.

● The actual play time and the time
displayed on the main unit may
differ for VBR files.

NOW PLAYING

Now Playing  01 of 10

artist Norah  Jones
Come Away With...
Seven Years

album

track

00:25 06:00

NOW PLAYING

Now Playing  01 of 10

artist Norah  Jones
Come Away With...
Seven Years

album

track

01:25 05:00

NOW PLAYING

Now Playing  01 of 10

artist Norah  Jones
Come Away With...
Seven Years

album

track

00:05 06:20

PLAY

FF

REW

NOW PLAYING

Now Playing  02 of 10

artist Position
Original

Stop Draggin My Heart Ar

Seven Years

album

track

00:25 05:30

NOW PLAYING

Now Playing  01 of 10

artist Norah  Jones
Come Away With...album

track

00:01 06:25

NOW PLAYING

Now Playing  03 of 10

artist Moon Jung Won
Love
DEAR DIARY

album

track

00:01 05:30

PLAY

PLAY

PLAY

NOW PLAYING

Now Playing  02 of 10

artist Position
Original

Stop Draggin My Heart Ar

Seven Years

album

track

00:25 05:30

NOW PLAYING

Now Playing  01 of 10

artist Norah  Jones
Come Away With...album

track

00:01 06:25

NOW PLAYING

Now Playing  03 of 10

artist Moon Jung Won
Love
DEAR DIARY

album

track

00:01 05:30

STOP

PLAY

PLAY

Using Your Samsung Napster Player
- Searching Within Music Files
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Use the Hold feature to lock and disable all buttons. The Hold feature is useful to
prevent your Samsung Napster Player from being accidentally turned off or on, or
to ensure uninterrupted playback.

Hold Function of the Main Unit

Activate             on the main unit.

❈ All buttons on the main unit will be disabled, and only the buttons on

the remote control can be used for input.

❈ When you activate the Hold switch, a "        " appears on the display.

❈ appears on the display.

Hold Function of the Remote Control

Activate       on the remote control.

❈ All buttons on the remote control will be disabled, and only the buttons on
the main unit can be used for input.

Using Your Samsung Napster Player
- Hold Feature

Now Playing

Library

FM Radio

Setting

FM Transmitter

Menu

Press the Menu button to switch to MENU mode.
Use the Scroll Up/Scroll Down buttons to select the menu item you want, and
then briefly press the Select button.

● Now Playing: Display the song currently playing.

● Library: Search and select music to play.

● FM Radio: Listen to FM radio

● Settings: Change the settings.

● FM Transmitter: Listen to your music by transmitting it wirelessly to another FM radio

Note
● In MENU mode, press the Menu button to exit from the submenu you are in.

Using Your Samsung Napster Player
- Menu Mode
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Searching for and Selecting Music Files

In the MENU, use the Scroll Up/Scroll Down buttons to select the Library, and
press the Select button.

● Tracks: Shows the song title from the ID3 tag information stored in the music file.
● You can use the Volume Up, Down buttons to move, 

and then press the Select button to play the selected song.

● Artists: Shows the artist name from the ID3 tag information stored in the music file. 

● Select the artist name, and then press the √» button.
All song titles corresponding to the artist name will be played.

● If you select an artist's name, song titles that correspond to that artist name will be   
displayed.

● You can use the Volume Up, Down buttons to move, and then press the Select 
button to play the selected song.

Britney Spears

DEAR DIARYArtists
DON’T LET ME BE THE LAS
GIRLIN THE MIRROR
OOPS! I DID IT AGAIN
WHEN YOUR EYES SAY IT

Artists

Artist Artists
Britney SpearsTracks
Johann SebastianBach
Sissel
Solid

Library

Artists
Albums
Tracks
Playlists

Library

Artists
Albums
Tracks
Playlists

Original

Stop Draggin’ My Heart Artists

Albums

8701Artists
AlbumTracks
BEST BALLADE & HIP HOP
Classical Music
Original

Library

Artists
Albums
Tracks
Playlists

Tracks

03-COME AS YOU ARE
ADDICTED TO YOU
DEAR DIARY
DON’T LET ME BE THE LAS

● Albums: Shows the album title from the ID3 tag information stored in the music file.
● Select the albums, and then press the √» button.

All song titles corresponding to the album name will be played.
● If you select an album name, song titles corresponding to that album will be displayed. 
● You can use the Volume Up, Down buttons to choose a song, and then press the  Select  

button to play the selected song.

Using Your Samsung Napster Player
- Browsing Your Music

CCoonntt iinnuueedd.. .. ..
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Press the Menu button. 
Select the FM Radio in the main menu and then press the Select button.

Switching to FM Mode

Pull and hold the œœ / √√.
You can search for a station automatically.

Automatically Scanning for a Station

Briefly pull œœ / √√. You can search for a station manually.

Manually Tuning In a Station

Using Your Samsung Napster Player
- Playing FM Radio

Playlist

Now Playing
My Faves
Dance Tunes
Driving Music

NOW PLAYING

Now Playing  01 of 10

artist Britney Spears
Oops!.... I Did It Again.....

When your Eyes s
album

track

00:00 06:25

Library

Artists
Albums
Tracks
Playlists

STOP

Selecting a Playlist

In the Library, use the Scroll Up/Scroll Down buttons to select
Playlists, and then press the Select button.1
Select the playlist that you want to play, and then press the 
Select button.
● The selected playlist will be played.

2

CCoonntt iinnuueedd.. .. ..
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NOW PLAYING
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Seven Years

album

track

00:01 06:25

FM RADIO

MO 33PRESET
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PLAY

Now Playing

Library

FM Radio

Setting

FM Transmitter

Menu
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Note
● You will need to adjust the volume level from your external audio device or FM

radio because the volume level of transmission in FM Transmission mode is set to
a fixed level.

This feature allows you to play music stored on your player through your home or car radio
using FM transmission.

Plug the FM transmission antenna into the FM transmission antenna jack. 

Inserting the FM Transmission Antenna

Using Your Samsung Napster Player
- Playing Music Via FM Transmission

33PRESET

FM RADIO

MO

FM RADIO

MO

87.9 MHz

33PRESET

FM RADIO

MO

87.9 MHz87.9 MHz

5PRESET

At the station you want to preset, press and hold the MENU button.1
Pull the œœ / √√ to select the location to which you want to store the station.2
Press the √» to store the selected station.
● Briefly press the √», and then use the œœ / √√ to search for the station you want.3

Presetting FM Stations

Note
● To delete a station, press and hold the MENU button.
● You can preset up to 40 stations.
● You can preset a new station into the location that already has a station stored.
● After storing the station you want, press the √» button. When PRESET appears on the display panel, 

use œœ / √√ to select the preset station.

CCoonntt iinnuueedd.. .. ..
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Press the Record button while
listening to FM radio.
● The current FM broadcast will be recorded

into an MP3 file.

1

Press the Record button again.
● Recording stops and the file is created.
● Files are recorded and renamed M0001,

M0002, and so on.
● MP3 files are automatically added to your

Library.

2

33PRESET

RECORD

REC

Recording-M0001.mp3
00:00:01

44KHz   :   128kbps
L
R

33PRESET

RECORD

REC

00:00:20
44KHz   :   128kbps

L
R

Recording STOP...

Note
● If no sound is heard while recording, check if the monitor volume in the recording setting

menu is set to "Mute".

Using Your Samsung Napster Player
- Recording From FM Radio

Press the Menu button to switch to Menu mode, use the Scroll Up/Scroll
Down buttons to select FM Transmitter, and then press the Select button.1
Use the Scroll Up/Scroll Down buttons to set the transmission frequency
you want.
● Press the Select button to store the selected frequency.

2

Set the external audio device's FM frequency to the transmission
frequency and play a song. You will now be able to listen to music on your
player from the FM radio on your home or car stereo.

3

Selecting the FM Transmission Frequency

87.7 Mhz

FM Transmitter

Choose Station:
Now Playing

Library

FM Radio

Setting

FM Transmitter

Menu



54 -  Samsung Napster YP-910 Player Samsung Napster YP-910 Player - 55

Note
● Before you begin recording, verify

that the battery is fully charged,
otherwise your recording process
may not complete successfully.

● Available recording time is displayed
at the center right of the unit when
recording starts. If there is no
remaining capacity, recording stops
automatically.

While in Music mode, use the Line-In cable to
connect the main unit's LINE-IN jack and the
LINE OUT jack of your external audio device.
● Connecting the Line-In cable to the HEADPHONE

OUT jack of your external audio device may distort
the recording because the headphone jack's output
is too high. Be sure to connect the Line-In cable to
the LINE OUT jack.

1 Press the Record button to start recording.2

Press the Record button again stop recording. 
A new MP3 file will be created.
● Files are recorded and renamed M0001.mp3,

M0002.mp3, and so on.
● A recorded MP3 file is automatically added to the

current playlist.

3

33PRESET

RECORD

REC

Recording-M0001.mp3
00:00:01

44KHz   :   128kbps
L
R

33PRESET

RECORD

REC

00:00:20
44KHz   :   128kbps

L
R

Recording STOP...

Your Samsung Napster Player can be to used to record directly from any external audio
source such as a CD player, cassette player, home stereo or radio.

Note
● Once you import the track to Napster, you can edit the track name to your preference.

Using Your Samsung Napster Player
- Recording MP3s
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Settings

Rpt/shuffle - One
EQ - Rock
Record Settings
Backlight - 1SEC
Contrast - 3
Reset
About

In the Menu, use the Scroll Up/Scroll Down buttons to select
Settings, and then press the Select button.1
Use the Scroll Up/Scroll Down buttons to select Rpt/shuffle.2
Press the Select button until the desired mode appears.
● Select the desired mode, and then press the Menu button to go to the main menu.3

● Off: Select this to listen to songs in the current playlist one at a time in the given order.
● Shuffle: Select this to play all stored tracks in random order.
● One: Select this to repeatedly play just one track.
● All: Select this to repeatedly play all tracks in the current playlist.

Note
● Only shuffle or repeat modes will be indicated.

Additional Features
- Shuffle and Repeat Playback

Settings

Rpt/shuffle - One
EQ - Rock
Record Settings
Backlight - 1SEC
Contrast - 3
Reset
About

In the Menu, use the Scroll Up/Scroll Down buttons to select
Settings, and then press the Select button.1
Use the Scroll Up/Scroll Down buttons to select EQ.2
Press the Select button until the desired mode appears.
● Select the desired mode, and then press the Menu button to go to the upper menu.

Off ➔ Rock ➔ Pop ➔ Classical ➔ Jazz ➔ Bass Boost

3

Additional Features
- Equalizer Settings
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Recording Settings

Sampling Rate - 44 Khz
Bit Rate - 128 Kbps
Monitor Volume - On

Settings

Now Playing

Library

FM Radio

Setting

FM Transmitter

Menu

Rpt/shuffle - One
EQ - Rock
Record Settings
Backlight - 1SEC
Contrast - 3
Reset
About

In the Menu, use the Volume Up, Down buttons to select Settings, and
then press the Select button.1
Use the Volume Up, Down buttons to select Record Settings,
and the press the Select button.2
Use the Volume Up, Down buttons to select Sampling Rate, Bit Rate, and Input Level, 
and then briefly press the Select button to make the desired recording setting.
● Complete the desired setting, and then press the Menu button to go to the main menu.

● Sampling Rate: Each time the Select button is pressed, the selection toggles 
between 32KHz and 44KHz.

● Bit Rate: Each time the Select button is pressed, the selection changes as follows: 
96 ➔ 128 ➔ 160Kbps.

● Monitor Volume: Each time the Select button is pressed, the selection toggles 
between On and Mute.

3

Additional Features
- Recording Settings

Settings

Rpt/shuffle - One
EQ - Rock
Record Settings
Backlight - 1SEC
Contrast - 3
Reset
About

In the Menu, use the Volume Up, Down buttons to select Settings,
and then press the Select button.1
Use the Volume Up, Down buttons to select Backlight.2
Press the Select button until the desired Backlight On-Time appears. 
● The setting range of Backlight-On Time is 0 to 9 seconds. 3

Backlight

Additional Features
- Screen Settings

CCoonntt iinnuueedd.. .. ..
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Settings

Rpt/shuffle - One
EQ - Rock
Record Settings
Backlight - 1SEC
Contrast - 3
Reset
About

In the Menu, use the Volume Up, Down buttons to select Settings,
and then press the Select button.1
Use the Volume Up, Down buttons to select Contrast.2
Press the Select button until the desired screen contrast appears.
● The setting range of the contrast, which adjusts the contrast of the 

screen, is 0 to 7.

3

Contrast

Settings Reset

Reset all default
settings?

YES
NO

Rpt/shuffle - One
EQ - Rock
Record Settings
Backlight - 1SEC
Contrast - 3
Reset
About

In the Menu, use the Volume Up, Down buttons to select Settings,
and then press the Select button.1
Use the Volume Up, Down buttons to select Reset, and then
press the Select button.
● If you select Reset, all selected settings will be restored to the default

setting.

2

Volume = 9
Rpt/shuffle = Off
EQ = Off
Backlight = 1Sec
Contrast = 3
DisplaySpeed = Off
FM freg = 99.9MHz

Default Setting

Additional Features
- Restoring Default Settings
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In the Menu, use the Volume Up, Down buttons to select Settings,
and then press the Select button.1
Use the Volume Up, Down buttons to select About, and then
press the Select button.
● If you select About, you can chack the total number of songs stored, total

capacity, available capacity, and version information.

2

About

Settings

Rpt/shuffle - One
EQ - Rock
Record Settings
Backlight - 1SEC
Contrast - 3
Reset
About

About

Total Track                        26
Capacity                   9749MB
Available                  9575MB
Version                           0.03

Additional Features
- Player Information

The backlight does not come on.
● Check the backlight setting.
● The Samsung Napster Player is designed to turn off the backlight automatically for longer

operating time when the battery's residual voltage is low.

The player doesn't work. There is nothing showing on the display panel.
● Check the battery's power level.
● Make sure the Hold switch is in the off position.

I cannot download files.
●  Check the battery's power level.
●  Check if the driver is installed correctly on your PC. (see page 20)

Reinstall the software from the installation CD. 
●  Check the USB connection between the player and your PC.
●  Check if there is the "unplug/eject or Safely Remove Hardware" icon located in

your icon tray at the bottom of your screen.

There is no sound even if I press the Play button in Music mode.
● Check if there are MP3 or WMA files on the Samsung Napster Player.
● Non-playable file formats (e.g. MPEG1 LAYER 1 file) cannot be played.

Delete the file from your PC before using the player. 
● Files that have been downloaded without using the Napster client cannot be played.
● Downloaded music files cannot be played if they are not shown in the selected playlist.

Customer Support
- Troubleshooting

CCoonntt iinnuueedd.. .. ..
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It takes a long time when I search songs by Song Title, Artist, or Album.
● If there are many music files on your hard disk, it will take longer to read them .

During playback, some unknown characters are displayed on the display panel. 
● Samsung Napster Player supports only English and unsupported languages will be

indicated by an asterisk ( ✻ ).

A "/Noartist/Noalbum" file path appears on the playback screen in place of the
selected music file's song title.
●  There is no ID3 tag information for the music file. Edit the song title, artist, and

album information of the song.

I have questions about using Napster.
● See the Napster online User Guide and FAQs for troubleshooting help with Napster.

The LCD window is too dark.
● Check the screen brightness control.

The playback time display during playback does not seem right.
● Check if you are not playing a VBR (Variable Bit Rate) file. VBR files are only partially supported.

Model

Processor

Internal Memory Capacity

Voltage

Playing time

Dimensions/Weight

Case

File Transfer Speed

Signal to Noise Ratio

Earphone Jack Output Power

Output Frequency Range

Temperature Range

FM Frequency

FM Signal to Noise Ratio

FM T.H.D

FM Useable Sensitiivity

File Support

Samsung Napster YP-910 Digital Audio Player

90Mips RISC

20G

3.7V (Li-Polymer Rechargeable Battery)

Maximum Operating Time: 10 hours

70 ✕ 108 ✕ 20mm/60g

Aluminum/Plastic

Max. 120 Mbps

90dB with 20KHz LPF (based on 1KHz 0dB)

7mW/CH (16Ω )

20Hz~20KHz

-5 ~ +35°C (23 ~ 95F)

88.0 ~ 108.0 MHz

45 dB

1%

10 dB

MPEG1/2/2.5 Layer 3 (8Kbps ~ 320Kbps, 8KHz ~ 48 KHz)

WMA (48Kbps ~ 192Kbps, 8KHz ~ 48KHz) 

Customer Support
- SpecificationsThe buttons on the Samsung Napster Player do not respond.

● Check if the Hold switch has been activated.
● Check if the USB cable is connected. Buttons do not work if the USB cable is connected.
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FCC Part 15: This equipment has been tested and found to
comply with the limits for a Class B digital device, pursuant to
Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a
residential installation. 
This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio
communications. However, this notice is not a guarantee that
interference will not occur in a particular installaion. If this
equipment does cause harmful
interference to radio or television reception, which can be
detemined by turning the equipment off and on, the user is
encouraged to try one or more of the following measures:

Any changes or modifications not expressly

approved by the grantee of this device could

void the user’s authority to operate the device.

Name: Samsung Electronics Co., Ltd

Address: 416, Maetan-3Dong, Paldal-Gu, Suwon

City, Kyungki-Do, Korea 442-742

declares under its sole responsibility that the product

Trade Name: Samsung Electronics Co., Ltd

Model Number:  YP-910

has been tested according to the FCC/CISPR22/95

requirements for Class B devices and found

compliant with the following standards

This product conforms to the following
Council Directive:
● Directive 89/336/EEC, 92/31/EEC(EMC)

● Reorient or relocate the receiving antenna. 

● Increase the distance between the equipment and receiver.

● Connect the equipment to an outlet on a circuit different from  
that to which the receiver is connected.

● Consult the dealer or an experienced radio/TV technician.

Modifications

Compliance

Declaration of Conformity

EMI/EMC: AnSI C63.4 1992, FCC Part 15 Subpart B

This device complies with part 15 of the FCC Rules.

Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and

2. This device must accept any interference received, including 

interference that may cause undesirable operation.

Party Responsible for Product Compliance

Samsung Electronics America

QA Lab.

3351 Michelson Dr. Suite #290

Irvine, CA92612

Customer Support
- Communications Regulation Information
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Samsung warrants this product as free of
defects in material, design and workmanship
for the period of twelve(12) months from the
original date of purchase.

If during the period of warranty this product
proves defective under normal use and service,
you should return the product to the retailer from
whom it was originally purchased. The liability of
Samsung and its appointed maintenance
company is limited to the cost of repair and/or
replacement of the unit under warranty. 
Return of the product for defective reasons
should be to the original purchaser, however
Samsung Authorized Dealers and Authorized
Service Centers will comply with the warranty on
the terms issued to purchasers in the country
concerned, for further information relating to the
Authorized Service Centers contact.
1-800-SAMSUNG (1-800-726-7864)
www.samsungyepp.com

WARRANTY CONDITIONS:

1. The warranty is only valid when the warranty card is
properly completed, and upon presentation of the proof of
purchase consisting of original invoice or sales slip
confirmation, indicating the date of purchase, dealers
name, model, serial No. and product number.
Samsung reserves the right to refuse warranty service if
this information has been removed or changed after the
original purchase of the product from the dealer.

2. Samsung's obligations are to the repair of the defective
part, and at its discretion, replacement of the product
(service exchange unit).

3.Warranty repairs must be carried out by an Authorized
Samsung Dealer/Service Center. No reimbursement will
be made for repairs carried out by non Samsung Centers,
and warranty coverage will not be valid for any repairs or
damage caused by such repairs.

4. Repair or replacement under the terms of this warranty
does not give right to extension to or a new starting of the
period of warranty. Repair or direct replacement under the
terms of this warranty may be fulfilled with functionally
equivalent service exchange units.

5. The warranty is not applicable in cases other than
defects in material, design and workmanship. The
warranty does not cover the following:

◆ Periodic checks, maintenance, repair and replacement
of parts due to normal wear and tear.

◆ Abuse or misuse, including but not solely limited to the
failure to use this product for its normal purposed or in
accordance with Samsung's instructions usage and
maintenance.

◆ The product has been used in conjunction with
accessories not approved by Samsung for use with this
product.

◆ Failure of the product arising from incorrect installation
or use not consistent with technical or safety standards
in current force, or failure to comply with product
manual instructions.

◆ Accidents, Acts of God or any cause beyond the control
of Samsung caused by lightning, water, fire, public
disturbances and improper 
ventilation.

◆ Unauthorized modifications carried out for the product
to comply with local or national technical standards in
countries for which the Samsung product was not
originally designed.

◆ Repairs performed by non-authorized service centers
such as opening of the product by a non-authorized
person.

◆ The model, serial No. and product number on the
product has been altered, deleted, removed or made
illegible.

6. This warranty does not affect the consumers statutory
rights nor the consumers rights against the dealer from
their purchase/sales agreement.

Customer Support
- Warranty
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THERE ARE NO EXPRESS WARRANTIES OTHER
THAN THOSE LISTED AND DESCRIBED ABOVE, AND
NO WARRANTIES WHETHER EXPRESS OR
IMPLIED,INCLUDING, BUT NOT LIMITED TO, ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE, SHALL
APPLY AFTER THE EXPRESS WARRANTY PERIODS
STATED ABOVE, AND NO OTHER EXPRESS
WARRANTY OR GUARANTY GIVEN BY ANY PERSON,
FIRM OR CORPORATION WITH RESPECT TO THIS
PRODUCT SHALL BE BINDING ON SAMSUNG,
SAMSUNG SHALL NOT BE LIABLE FOR LOSS OF
REVENUE OR PROFITS,FAILURE TO REALIZE
SAVINGS OR OTHER BENEFITS, OR ANY OTHER
SPECIAL, INCIDENTAL OR CONSEQUENTIAL
DAMAGES CAUSED BY THE USE, MISUSE OR
INABILITY TO USE THIS PRODUCT, REGARDLESS OF
THE LEGAL THEORY ON WHICH THE CLAIM IS
BASED, AND EVEN IF SAMSUNG HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES. NOR
SHALL RECOVERY OF ANY KIND AGAINST
SAMSUNG BE GREATER IN AMOUNT THAN THE
PURCHASE PRICE OF THE PRODUCT SOLD BY
SAMSUNG  AND CAUSING THE ALLEGED DAMAGE.
WITHOUT LIMITING THE FOREGOING, PURCHASER 

ASSUMES ALL RISK AND LIABILITY FOR LOSS,
DAMAGE OR INJURY TO PURCHASER AND
PURCHASER’S PROPERTY AND TO OTHERS AND
THEIR PROPERTY ARISING OUT OF THE USE,
MISUSE OR INABILITY TO USE THIS PRODUCT SOLD
BY SAMSUNG NOT CAUSED DIRECTLY BY THE
NEGLIGENCE OF SAMSUNG. THIS  LIMITED
WARRANTY SHALL NOT EXTEND TO ANYONE
OTHER THAN THE ORIGINAL PURCHASER OF THIS
PRODUCT, IS NONTRANSFERABLE AND STATES
YOUR EXCLUSIVE REMEDY. 

Some states do not allow limitations on how long an
implied warranty lasts, or the exclusion or limitation
of incidental or consequential damages, so the
above limitations or exclusions may not apply to
you. This warranty gives you specific legal rights,
and you may also have other rights which vary from
state to state.
This product is for personal use only, and is only for
use in compliance with the limitations of copyright
and other laws. 

To obtain warranty service, please contact
SAMSUNG at: 
Samsung Electronics America, Inc.
400 Valley Road, Suite 201 Mount Arlington, NJ
07856
Tel: (973) 601-6000, Fax: (973) 601-6001
1-800-SAMSUNG (1-800-726-7864)
www.samsungyepp.com
081299


